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Trademark notice

© 2019 ComNav Technology Ltd. All rights reserved.
SinoGNSS is the official trademark of ComNav Technology Ltd., registered in
People’s Republic of China, EU, USA and Canada.

FCC Notice

SinoGNSS® N5 GNSS receivers comply with the limits for a Class B digital device, pursuant to the
Part 15 of the FCC rules when it is used in the Portable Mode.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference;

(2) It must accept any interference received, including interference that may cause undesired
operation.

Copyright Notice

This is the V1.0 (Feb, 2020) revision of the N5 GNSS Receiver User Guide. It cannot be copied or
translated into any language without the written permission of ComNav Technology.

Technical Assistance

If you have any question and can't find the answer in this manual, please contact your local
dealer from which you purchased the N5 receiver. Alternatively, request technical support from
ComNav Technology Website: www.comnavtech.com or technical support email:

support@comnavtech.com. Your feedback about this Guide will help us to improve it with future

revisions.
Safety Information

Before using the receiver, please make sure that you have read and understood this User Guide,
as well as the safety requirements.

® Connect your devices strictly based on this User Guide
® [nstall the GNSS receiver in a location that minimizes vibration and moisture
® Avoid falling to ground, or colliding with other items
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Do not rotate 7-pin Lemo port
Do not cover the radio, keep a sound ventilation environment
To reduce radiation, please keep above 2 meters away from the radio station

Take lighting protection measures when installing antennas

Change the cable if damaged
Related Regulations

The receiver contains integral Bluetooth® wireless technology and UHF. Regulations regarding
the use of the datalink vary greatly from country to country. In some countries, the unit can be
used without obtaining an end-user license. But in some countries the administrative

permissions are required. For license information, please consult your local dealer.

Use and Care

The receiver can withstand the rough treatment that typically occurs in the field. However, the
receiver is high-precision electronic equipment and should be treated with reasonable care.

Warning and Caution

An absence of specific alerts does not mean that there are no safety risks involved. A Warning or
Caution information is intended to minimize the risk of personal injury and/or damage to the

equipment.

WARNING- A Warning alerts you to a potential risk of serious injury to your person and/or damage to
the equipment, because of improper operations or wrong settings of the equipment.

CAUTION- A Caution alerts you to a possible risk of damage to the equipment and/or data loss.

Warranty Notice

ComNav Technology does not warranty devices damage because of force majeure (lighting, high
voltage or collision).
ComNav Technology does not warranty the disassembled devices.
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The SinoGNSS® N5 GNSS Receiver User Guide is aimed to help you get familiar with the
N5 receiver and start your project effectively. We highly recommend you to read this
manual before surveying, even you have used other Global Positioning System (GPS)
receivers before.

With SinoGNSS® Quantum™ algorithm, N5 GNSS receiver can be applied in RTK mode
with all GNSS constellations. N5 receiver has ultra-small size and strong
anti-interference ability to make it possible to work even in harsh environments. It is
the ideal RTK/GNSS product for surveyors.

The SinoGNSS® N5 GNSS Receiver key features:
e Ultra small and super light
- Size (W x H): 15.5cm x 7.3cm
- Weight: 1.2kg (including 2 batteries)
e 574 channels of simultaneously tracked satellite signals

e Increased measurement traceability with SinoGNSS® Quantum™
algorithm technology

e Hot swap battery design

e Cable-free Bluetooth wireless technology

e 1 OLED display and 2 function buttons

e |P67 waterproof

e Full base/rover interoperability

e Integrated receiving & transmitting radio with 12.5KHz frequency interval

e Integrated IMU sensor

e Integrated WiFi module

e Integrated 4G module, support Ntrip and Point to Point/Points protocols

e Support long baseline E-RTK™ (Beidou B3 signal is included in RTK
calculate engine)

This section provides overall N5 receiver parts list, including basic supplies and
customized kits based on your requirements.
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1.3.1 Basic Supply kit

SinoGNSS® N5 GNSS Receiver Basic Supply kit contains two receivers and related
accessories.

Item Picture
2* Kits N5 Receivers w
1*GNSS Connector a”.f;‘,é
O
2*7-pin Lemo to R5232 N
Cable

2* 7-pin Lemo to USB Cable

External Power Cable

2* Whip Antenna (UHF) - —

1*2m-Range Pole with
yellow bag
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4* Lithium-ion Battery

2* Battery Charger

R550 Controller

Controller Battery, Charger l 8
and Cable

Controller Bracket

Optional accessories:

Double Bubbles Tribrach with
High Adapter

1* 30cm Extension bar e 1§

1.3.2 Optional Datalink kit

This kit is necessary for long distance radio communication, shown in the following
figures:
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Item Picture

External Radio

CDL5

2-pin Lemo Power
Cable

7-pin Lemo Data
Cable

N-Type to TNC
Convertor

N-type to N-type
Antenna Cable

N-Type Radio
Antenna

1.3.3 Transport Cases

Standard transport case is designed for containing basic supply kit of one SinoGNSS®
N5 GNSS Receiver.
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SinoGNSS

Base Rover

The optional choice is provided to have capacity of two kits of N5 receivers.
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2 Setting up the receiver

This chapter provides general information on environmental requirements, setup,
power supply and connection of the N5 receiver.

2.1 Environmental requirements

To keep the receiver with a reliable performance, it is better to use the receiver in
safe environmental conditions:

e Operating temperature: -40°C to +65°C

e Storage temperature: -40°C to +85°C

e Out of corrosive fluids and gases

e With a clear view of sky

2.2 Front panel

Receiver front panel contains one OLED display, Power button and Record button.
The indicator LEDs show the status of radio and satellite tracking. For detailed
information, see chapter 3.3.

'DOP:
A95%ME  B:95%M

2.3 Lower housing

Receiver lower housing contains a serial port, UHF radio antenna connector, two
removable battery compartments (the SIM card slot is located in compartment A),
and a threaded insert.



SinoGNSS® N5 User Guide

N5 GNSS receiver supports internal batteries and external power input.

The receiver is equipped with two rechargeable Lithium-ion batteries, which can be
removed for charging. The N5 receiver adopts the hot swap battery design that
provides you an effective survey workflow. The internal batteries typically provide
about 12-hour operating time as a rover, about 7-hour operating time if operated as
a base station with internal UHF Tx (transmit at 1-2 watts). However, this operating
time varies based on environmental conditions.

® Battery Safety
Charge and use the battery only in strict accordance with the instructions below:
- Do not use or charge the battery if it appears to be damaged. Signs of damage

include, but are not limited to, discoloration, warping, and leaking battery fluid.
- Do not expose the battery to fire, high temperature, or direct sunlight.
- Do not immerse the battery in water.
- Do not use or store the battery inside a vehicle during hot weather.
- Do not drop or puncture the battery.
- Do not open the battery or short-circuit its contacts.

® Charging the Lithium-ion Battery
Although a dual battery charge is provided, the lithium-ion battery is supplied
partially charged. To charge the battery, first remove the battery from the receiver,
and then place it in the battery charger, which is connected to AC power. Please
obey the following instructions when charging your batteries:

- Charge the battery completely before using it for the first time.

- Fully charge takes approximately 6 hours per battery at room temperature.

- If the battery has been stored for a long time, charge it before your field work.

- Re-charge the battery at least every three months if it is to be stored for long

time.

® Storage of the Lithium-ion Battery
- Do not keep batteries inside the receiver if the receiver not used for long time.
- Keep batteries in dry conditions.
- Take out the batteries from receiver for shipment.

7
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® Dispose of the Lithium-ion Battery
- Discharge a Lithium-ion battery before dispose of it.
- Dispose of batteries is an environmentally sensitive manner, and adhere to any
local and national regulations concerning battery disposing or recycling.

WARNING - Do not damage the rechargeable Lithium-ion battery. A damaged battery can
cause an explosion or fire, and can result in personal injury and/or property damage.

2.4.2 External Power Supply

The receiver is connected to an external power supply through a lemo to RS232
cable, and make sure that the red alligator clip is connected to the positive of
external power supply, black one to negative. Over-voltage function cannot
protect your N5 receiver if reverse connection.

Tip: The power consumption will be increasing if the base station transmits correction data
through internal UHF in the RTK mode; therefore, we strongly suggest using external power (7-28
volt DC) for the base station.

2.4.3 Charge Battery via N5 Receiver

N5 GNSS Receiver can work as a charger, it means you can charge batteries
directly if the charger not by your side.

1. Power off N5 receiver with batteries inside;

2. Connect N5 receiver to 12V external power with serial cable;

3. Receiver will charge the battery from Side B to Side A, the red power led will
flashing during charging and will off when battery full.

td o
Charge with a 12 VDC car battery
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To mount the receiver on a range pole as the figure shown below:

® Thread the receiver onto the range pole
® Mount the controller bracket to the pole
® Install the controller into the bracket

Tip: Do not tightly clamp the controller on the Range Pole.

This chapter introduces all controls for the general operation, including OLED display,
button functions and all LED behaviors on the front panel.

There are three interfaces on the OLED display, for let you know the status, work
mode of receiver and help you do some simple setting.

® Status interface:
Will show you the status of receiver. Including the solution status, satellite searching
condition, PDOP value and battery power.

® Work mode interface:
Will show you the work mode of receiver. Including protocol, frequency and Tx or Rx.
If the work mode is PDA Cors, there will no protocol, frequency and so on.

® Setting interface:

There will be some simple function settings, including smart base station, relay mode,
formatted memory, static data collection, WIFI control, language switching and
factory reset, etc.

Tip: Power button represents enter, and the raw data recording button controls you switch

function.
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3.2 Button functions

There are two buttons on the front panel, power button and record button.

® Power button:

Press the power button for about 1 second to turn on the receiver;

To turn off the receiver, long press the button for 3-4 seconds until all LEDs off.

® Record button:

Switch to static mode: Long press the record button for about 2 seconds, release
immediately when hearing beep from receiver;

Switch to RTK mode: press the button until Raw Data recording LED off.

Tip: The record button only works when receiving satellite signals, otherwise it will show timeout.

3.3 LED behavior

The LEDs on the front panel indicate receiver working status. Generally, a lit or
slowly flashing indicates normal operation, and an unlit LED indicates that no
operation is occurring. The following figure and table define each possible LED
state:

Differential Data
Satellite Tracking
OLED display

Raw Data Recording

Power

35-35

Satel
€ roor2.n1
\ A95% M B:95%E

LEDs States Description

Flashes once per second Receiving/transmitting differential

Differential Data data

Fast flashing No satellite received

Satellite Tracking
Flashes N times every 5 seconds | Received N satellite signals

10
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3.4 Receiver Web GUI interface

Step 1: Connect Wi-Fi of N5 receiver

Turn on the N5 GNSS receiver and wait for the N5 serial number to appear under
the available Wi-Fi networks on your smart phone or office computer.

For example, N5-0340XXXX (where xxxx represents the last four digits of the
receiver serial number).

Enter password: 12345678
Step 2: Login the Web

Select the receiver, open a web browser and then enter the following IP address:
http://192.168.1.1

Tip: Most web browsers for computers / laptops and smart phones / PDAs support the receiver
Web GUI

& S ) A (@ 192.168.1.1/ big = 4L e -
=), A
Version Info Position:
(T I Lat:31°21'0.06369" N Lon: 121°17'33 21549" E Alt:28.0291
Satellites
Data record Ellipsoid: WGS84 Fix Status: Single
Data Transfer Satellites Tracked: (21):
Bluebooth GPS(8): 10,2629,32,1422.25 31 GLONASS(2): 8,12
Broadcasting static
GPRS BDS(9): 123467101112 SBAS(0):
Network Config Satellites Used: (14):
GPS(4): 10262932 GLONASS(1): 8
BDS(9): 12,3.46,7,10,11,12 SBAS(0):
Receiver Clock:
GPS Week: 1994 GPS Seconds: 441151.000 UTC: 30/03/2018 02:32:13
DOP:
PDOP: 2.9008 HDOP: 18219 VDOP: 22573 TDOP: 2.1299

4 Static survey

This chapter describes static survey through N5 receiver and CRU software. For static
survey, you cannot change settings through front panel, you can configure it via
Compass Receiver Utility (CRU): 1) Receiver configuration; 2) check receiver settings
and status; 3) convert data to Rinex format.

4.1Receiver Configuration

1. Download and install CRU software from the link below (ensure the driver is

properly installed in your PC):
11
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http://www.comnavtech.com/download.asp?bigclassid=28

2. Connect the receiver with your PC through 7-pin lemo to USB cable.

3. Turn on your N5 receiver and click set port in CRU -> USB in the serial port option
-> enter proper baud rate -> click Ok to complete receiver connection. The SN of
receiver will appear in the title bar if connected successfully.

BB Compass Receiver Utility [Unkown receiver] - C\Users\Sophia\Desktop\Kaing - O X
App Connection Receiver Radio GNSS Rinex View Help
»
St Fort | Connect -
Folders Messages [ -
Project Name | D | Size | Count
S I
Messages * Serial Port oM ,Fi‘
F
‘.50 Baul Rate [115200
Tracking
" TCP Client Host |
',__/—;
0
Port
World Map
3 ¢ Data File |
— 1
= 256 B/s
File Download B
@ Setup | Ok | Cancel |
Rinex Convert
v

[TEN

Ready Diff 0 B/S CAP NUM
Tips: two types of cable are provided in your package,

1) We recommend to use 7-pin Lemo to USB cable to configure the receiver and raw
observation data downloading;

2) With 7-pin Lemo to RS232 cable, you can connect N5 receiver with external power or

firmware upgrade.

4. Click Config to configure the receiver:

® Sample Interval: change the sample interval of observations, the maximum data
rate is 20 Hz, the minimum is one observation per minute.

® Mask angle: disable the receiver to track satellites that below the mask angle.
You can set mask angle values for different constellations, which can reduce
serious multipath influence or low SNR.

® Data Log: logging data manually or automatically.

® Data Log Session: 1) Manual means that the receiver keeps recording data in
one file until the receiver is turned off or its memory runs out; 2) if set to
1\2\3\4\12 hours, the data recorded will be saved into a file every 1\2\3\4\12
hours.

12
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Receiver Configurations x
Ttemn | Parameter 2 Default Settings
Model of the receiver |2001
Receiver No. 302520 Refresh Settings
Date of manufacture 2018/03/01

Option Mo Apply Settings

[Version H:1.12 B:5.0.1 5:3.6.8

Memory 755MB Register Receiver
_

GPS Mask Angle(degree) 10 Update Firmware
BDS Mask Angle(degree) 10 =
GLOMASS Mask Angle(degree) 10

GALILEQ Mask Angle(degree) 10

Data Log Manual

Data Log Session Manual

PorL onngrauon IO Tl

Work Mode Mormal

Correction Port Port 1

Format of Correction CMR

Register Code 16777215-42049-67295 v Exit

5. Complete all configurations and click Apply Settings to save settings. Exit and

restart the receiver to activate configurations.

Static survey is mainly used for the control survey. To reach millimeter accuracy,
follow as below:

Tip:

At least 3 GNSS receivers are required to form a stable triangulation network.
It is better to set Data Log Session as manual on the known point.
Power off the receiver before moving to other observation site.
To quickly post-process static observation raw data, write down the station
name, receiver SN, antenna height, start and end time for each observation
site.

You can start recording static data in the front panel, it’s convenient for you.

The raw observation data is saved in internal memory of N5 receiver, when
connected with PC via USB cable, the N5 receiver can work as a USB Flash Disk,
which means you can copy or cut static data to PC directly.

13
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@Q = » Computer » COMNAV_DISK (GJ) » <[l

File Edit View Tools Help

Organize v Share with v New folder B ] 0
. -
¢ Favorites — 4/ile folder (8)
Bl Desktop
20170520 20170919
% Downloads File folder i I File folder
] Recent Places =
Ji Technician | 20171206 20171218
i ’ File folder ] I File folder
3 Libraries
[ Documents i | 20171226 20180112
J’ . ! File folder i l File folder
Music
[&=] Pictures
& 20180330 RECYCLER
B Videos ! File folder File folder
1% Computer
& Local Disk (C:)
ca THE (D)
TS (E)

e COMNAV_DISK (G:)

“! Network
18 ONORIVIPUFISWPA
% ADMIN-PC
1% ADMMIN-PC
% CHo1014
8 COMNAV021
% COMNAV078
% COMNAV140623
& COMNAV200

8 items

-

Tip1: Default memory for N5 receiver is 8GB, and 16GB, 32GB optional.
Tip2: The receiver will stop recording raw data if the internal memory runs out.

4.4RINEX Convert

After copy raw observation data to PC, you can convert the data from ComNav
binary format (*.cnb) to RINEX in CRU software.
1. Start CRU software;

2. Click Folders and select the path of your CNB data;

3. Click Rinex Convert to check all raw data on main window. Right click on the file to

modify antenna, Convert Settings and Convert to RENIX, or use fast icon in standard
bar.

14
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B Compass Receiver Utility [2001T33-301007 USE] - C\Users\Sophia\Desktop\1007,20170513 — a e
App Connection Receiver Radio GMNSS Rinex View Help

@ i A £

Diff  attitude command  lock

Close

Folders
Project

Messages

<
Tracking
World Map
e
File Download
Rinex Convert

Ready

Micde

Messages

Rinex Convert [J

File Download hd

= g

Artenre pacdify Comvert  Sstup B:inex‘

File name Download time |
@i 103301007134A0.cnb | :
03301007134A0.cnb 2018-03. Convert to RINEX

Size(KB) | Recelver No. Marker Model

Convert Settings
Antenna
Madify

Rinex Analyse

rmm 03301007 1908 |

>

Diff 0 B/S CAP NUM

-

Click s to select the Antenna Type and Measurement. If you cannot find

N5 antenna, 1) input the value of RO (horizontal offset from measurement
mark to phase center), hO (vertical offset from measurement mark to phase
center) and h1 (vertical offset from measurement mark to receiver bottom). RO
is 0.0775m, hO is 0.0325m and h1 is 0.038m respectively for N5 receiver; 2) or
check Enable antenna configure file to select Antennas.ini file to select
Antenna type again. You can also add, edit and delete antenna types based on
your requirement.

® Click ﬁ to change Convert Settings,

Select Antenna ’?‘@
[¥ Enable antenna configure file
|C:\Program Files\Compass\Antennas.ini
Antenna Type |N5 j
Measurement -

RO = |[0.077500 m
ho = [0.032500 m
h1= ’W
Add
Edit
Delete

observation information.

15
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Rinex Setup x
Export Format Sample Rate
-] fAuto E
Marker name method of *.cnb file By @i
Pseudorange FPhase S/N  Doppler
|F0ur characters in file name j
GPS L1
GPS L2P
Advanced GPS L2C
GPS L5
GPS Week |0 BDS B1

I Smooth Pseudorange Epoch |0 LIS [
BDS B3

GLONASS L1
GLONASS L2
GALILED E1C
GALILED ESB
GALILEO ESA

Cancel ‘ OK |

Tip: In some Post Processing software, the BeiDou observations cannot be processed, you can

EUIE I 4 B4 I A B I

AN AIAAR"TAT A
QA AIAARR TR A
A AR T A

<l = %

uncheck the BeiDou B1,B2,B3 observations.

® Click cﬁ to Convert to RINEX, the RINEX data will be save in the same path
as raw observation data.
5 Real-Time Kinematic Survey (RTK)

This chapter introduces how to conduct RTK Survey with Survey Master
Software, including software installation, start a new project, receiver
connection and RTK working modes (Radio, CORS and GPRS).

5.1 Installation of Survey Master

Survey Master is available on Google play, you can download for free and install the
software to SinoGNSS controller R550.

Also you can download the latest version from our website:
http://comnavtech.com/download.asp?bigclassid=28

5.2 Wizard function in Survey Master

Follow the Wizard, you can quickly learn the general workflow of Survey Master, also
you can quick start your survey by this function no matter you are experienced one
or new user.

In Project menu, tap Wizard.

1. Project: Click Select to go into Project interface to create or select a project. For

16
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detailed information, you can refer to chapter 5.3.

ComNav Help & Wizard Help & Project Help

Project list

o
(o}
b o Project
China/WGS 84 View >
Wizard Project Datum 26-12-2019 15:46:53
Select Next
@ @ 9 Connection
Connect device via Bluetooth

9 Work mode
Start receiver as Base or
@ Rover(Mode:radio,network)
Import Export Export Result o Start work
E . . Select work type and start working!
Features Cloud Settings
Project Device Survey Tool B + o oD
Cennect 1o device Open Create Upload Download

2. Connection: Click Select to go into Bluetooth connection interface. For detailed
information, you can refer to chapter 5.4.

& Wizard Help & Connection Help

. Project Device model ComNav >
ComNav
. Connection type Bluetooth >
e Connection w
Connect device via Bluetooth
Target device :—] 03401012 >
Previous Select Scan QR code on receiver to build connection
Click arrow on the right to change Bluetooth device.

e Work mode

Start receiver as Base or
Rover(Mode:radio,network)

o Start work

Select work type and start working!

Connect to device

3. Work mode: Click Select to go into QuickSetup interface to start your receiver as
Base/Rover. For detailed information, you can refer from chapter 5.5.

If you start your receiver as Rover, then you can start work directly of topo survey or
stakeout.
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é S = é S i

Current Mode: Rover

Project roj

o ) Work mode list ° Project
ComNav ComNav

’ Connection Default: RadioMode o Connection
03401012 @ Intemal radio: 6/460.0500MHz 03401012

e Work mode ‘ Work mode

Start receiver as Base or
Rover(Mode:radio,network)

Previous Select

o Start work

Select work type and start working!

Rover/PDA CORS

Default: InternalGSM(ComNavServer) 211.144.120.104:8888

SinoGNSS://211.144.120.104:8888/

o Start work
Select work type and start working!

DS)_] Topo survey

r? Stake Point

r/@ Stake Line

If you start your receiver as Base, after Disconnect with Base, there will be a Prompt.
YES: will guide you to start Rover in Wizard interface;
NO: will disconnect the base and exit Wizard.

= 6 e -

Current Mode: Rover

Work mode list . Project
ComNav
Default: InternalRadio @ connection
@ Internal radio: 6/460.0500MHz, 2.0W 03401012
. Work mode
. Base/Internal radio
Default: ExternalRadio Frequency(MHz):460.05
External radio: 6/460.0500MHz, 30W Prompt
0 Base

Disconnected with Base, do you want

Succeed, pls disconnect with Base

Disconnect with Base

e Default: InternalGSM(ComNavServer) 1o setup Rover?

SinoGNSS://211.144.120.104:8888/

Add Apply

5.3 Start a New Project

Click Project, you can use the same Datum with last project, choose a datum in store

and scan QR code from other controller to add Datum, even sharing project with
cloud.
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Use Last project

Datum store

Scan QR code

O
©
©

Features Cloud Settings

= ® ® O

Project Device Survey Tool

Connect to device

® Select a Predefined datum: You can select datum directly from the list. Survey
Master currently has 43 countries datum and will add more afterwards.

& Datum Store Help

Datum list

China/Beijing 1954 China
China/Xian 1980 Argentina
China/CGCS2000 Australia
China/WGS 72 Azerbaijan
China/WGS 84 Belgium
China/Shanghai Brazil

Cameroon

Chile

Egypt

Predefined || User defined n

® Create a User defined datum: If you cannot find datum you want in the list,
follow instructions below to add one: select Ellipsoid, Projection for your datum,
and even seven parameters, geoid model based on your request.
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& Datum Store Help & Add datum Help

i
Retmlst Datum !LOCALI X l
China/Beijing 1954

Ellipsoid Choose ellipsoid >
China/Xian 1980 Ree! 1005 ellpsolc
China/CGCS2000 Projection Please select projection >
China/WGS 72

Seven parameters Close >
China/WGS 84

H.RMS Close >
China/Shanghai

V.RMS Close >

Geoid Model Not use >

Tip1: if asked username and password for seven parameters, enter admin admin
Tip2: For H.RMS and V.RMS, it will show if do Site Calibration.

® Share Datum via QR code.
® After you build a project, press the project name, it will generate a QR code.
Users can use the Scan function in the main interface to access the coordinate

system.
o

Project name ComNav

/storage/emulated/0/

Path Sinognss/sm/Project/ComNav

Wizard Project Datum
Code
Create time 26-12-2019
Operator
Element Code Basemap Comment
@ @ Datum China/WGs 84 ae
Import Export Export Result Ellipsoid WGS 84
a 6378137.000
@ @ 1f 298.257223563000
Features Cloud Settings Azimuth System  North
Positive Direction N, E
Projection Ut™m
Zone 51
E @ @ C] Hemisphere N

Project Device Survey Tool
Connect to device “

5.4 Bluetooth connection

To connect Survey Master with N5, switch to Device interface, tap Connection to go
into Bluetooth connection interface.
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® Make sure device Bluetooth turned on;
® Click Find device—select SN of your N5 receiver—allow pair
After connect ComNav receiver, you can check the device version in Device Info.

€ Connection Help
Device mode ComNav >
Connection type Bluetooth >
Target device :—] 03401012 >
ComNav Click arrow on the right to change Bluetoath device.
@ Simulated Device
Position Info Register Static NMEA Device

e Controller GNSS

H-Terminal Debug data  Mock Location

o O] (]

Project Device Survey Tool

Connect to device

& Select device

Bluetooth .

Connect to device Connect to device

Available devices

(+) 03301015
(+) 03401012

Connected
Pair with 034010127

Device connected

D Allow access to your contacts and call
history

@ Rover O Base
CANCEL PAIR
CANCEL SETTING

Find device Connect to device

After connected successfully, the bottom will show the positioning status.

[]36&300/00

(@) § D:200 H:0.000 V:0.000

Device

N:3469646.196 Status:Single
E:337564.380 Z:8.206
Lz {8 3] DOH1.356 V:1.5%0
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Tip: If you are failed to connect with receiver through Survey Master, you can just follow prompt
info to go into the device Bluetooth setting interface to make sure Bluetooth paired successfully.

Sometimes you need restart the receiver or Survey Master Software.

5.5 Internal Radio Mode

N5 GNSS receiver supports transmit & receive the correction data in internal radio
mode. To conduct the RTK survey in internal radio mode, it requires:

N\ @ A controller with software
i 2 installed
@ An extension bar
| ® Two units of N5 GNSS

receiver

@ Two whip antennas

— ® A range pole with bracket
® Tripod and tribrach

Tip: The external power supply is recommended when N5 set as a base station.

More: Aim to improve the radius of work field, we can change the base receiver’s Whip

Antenna to External Antenna. And others no need change.

®©

(D N5 GNSS Receiver
(2 External Antenna

5.5.1 Start Base Station by Survey Master

Firstly, build Bluetooth connection between the N5 receiver and your controller
as shown in Chapter 5.4.

Secondly, modify parameters including correction format, antenna type and
communication protocols:

® Click Device-> Base ->Add, select Internal radio.
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A "

= ComNav Help &  Base Help & Datalink Type
= (ErBlibEL: s Datalink Type Internal radio >
oz Work made list

Connection Rover Base Protocol Transparent >

0 Default: InternalRadio

Internal radio: 6/460.0500MHz, 2.0W
. Power(W) 2.0 bd

©
o)

%

Antenna 0183 Output  Device Info Default: ExternalRadio Channel Customize > ()
@ External radio: 6/460.0500MHz, 30W
o ) Frequency(MHz) — 453l0500 X +
5 ©
- ; - Default: InternalGSM(ComNavServer) Range(410-470MHz)
Position Info Register Static @ SinoGNSS://211.144.120.104:8888/
©
H-Terminal Debug data  Mock Location

] o © O

Project Device Survey Tool

N:3469646.099 Status: Single

E:337564.378 Z:8.080
L {8} D:0H:1.356V:1.590 Add Apply Confirm

& Datalink Type

Datalink Type Internal radio >
Protocol Transparent >
Power(W) 2.0 bd
® Choose Protocol and Frequency
Channel Customize )] .
for Base receiver.
Frequency(MHz) — 453l0500 X +

Range(410-470MHz)

Base

Datalink Type Internal radio >

Protocol Transparent

Frequency  2.0W/453.0500 ® Start mode: Fix position means
Differential mode RTCM3.2 > you have a known coordinate for
Srtmode  Fixposition > Base, or get a point from GNSS;
Mask angle ‘1(1 X

® Differential mode: Make sure to
choose RTCM32
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& FixPosition

Base station coor..  [RJETRITET Get

Name base:p0| X ‘
Code [ ‘

v _ ® Library choose: Choose a known
Display type Local grid coordinate > . f EI

oint from Elem;
N ‘3469655.236 ‘ p !
337581.203 . .

E [ | ® Get: Get a point coordinate from
Z poes | GNSS
Slant(S) ‘1.850 ‘

o Bottom of receiver(H) @ Slant(S)

Antenna type T30(NGS) >

When start Base succeed, it will show as below in Survey Master.

ComNav Help
Connection Rover Base

Base Config e
1 Setup Internal Radio .

Antenna 0183 Output  External radio
2 Setup receiver parameters

Q.

3 Generate Base @ @
Succeed, pls disconnect with Base Device Info Position Info Register

Frequency(MHz): 453.0500 i
=
0K

Wil closed after 2 seconds) Static H-Terminal Debug data
N
B o O )
Project Device Survey Tool
B:31°21'00.13138"N Status:Base
L:121°17'33.08475"E H:25.048
810821013 @ § 0:99H0.170V:0.114

5.5.2 Start Rover Station by Survey Master

® Connect Survey Master with N5 receiver via Bluetooth based on Chapter 5.4.
® Set same protocol and frequency with Base receiver.
® The current status on the bottom will change from Single to Fixed.
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Cca

Internal radio >
Current Mode: Rover

Work mode list : Transparent
0/453.0500
Default: RadioMode y 1Hz >
Internal radio: 6/460.0500MHz

10 Rover Config

1 Setup Internal Radio

Default: InternalGSM(ComNavServer)

SinoGNSS://211.144.120.104:8888/ 2 Setup receiver parameters

Succeed!
Frequency(MHz): 453.0500

OK

Will closed after 1 seconds.

« | I T

5.6 External radio mode

The external radio mode can extend RTK working distance, which is ideal for areas
with high constructions or strong signal interference. To set up external radio mode,
it requires:

@ Base station

@ An external radio
@ An external power supply
® Along whip antenna

@ Transmission cables
® A NS5 receiver
® Tripod and tribrach

Tip: 1) See Appendix A for detailed definition of 7-pin Lemo cable that connects the N5 receiver
and external radio; 2) See Appendix B for the operating information of CDL5.

Warning: 1) You MUST connect CDL5 to external antenna firstly and then supply power,
otherwise the CDL5 will have a risk of burnout; 2) You’d better put it in a shelter when raining,

because it’s not water-proof.
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® Rover station

< @ A NS receiver
1

@ A Whip antenna
® A controller with software installed

@ A range pole with bracket

® Click Device-> Base ->Add, select External radio.

& Datalink Type

Datalink Type External radio > [ ) When start succeed, set Up the

Protocol Transparent >

frequency channel, and Rover

Power(W) 30 >
frequency should be same.

Channel 6 > (=)
Frequency(MHz) — 460.0500 +

, , ® Be sure to set the same baud
Range(410-470MHz)
Airbaudrate 9600 > rate as your CDL5 (default value
Foudfe 38400 ’ is 38400, you also can change in
Select BaudRate for your External Radio, the other
parameters are only work for ComNav CDL5 External Radio. Param tab based on your CDLS).

5.7 PDA CORS Mode

Without setting up your own base stations, the N5 GNSS receiver can receive
correction data transmitted from continuously operating reference station via
PDA’s GPRS or WIFI. To do RTK survey in PDA CORS mode, it requires:
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R\
),

» ) / @® A NS receiver
N 7

@ A controller with SIM card and
software

\3 ® A range pole with bracket
\
|

1

4

{

.

B ———

Configure the Rover as below:

® Make sure your controller can access to internet via SIM card or Wi-Fi, then

run Survey Master Software.

® Build Bluetooth connection as shown in chapter 5.4, Click Device -> Rover ->
PDA CORS.

& Datalink Type

Datalink Type PDA CORS

v

CORS

® Enter CORS DNS/IP address and
port-> Click Source List and select
the proper source -> enter User
and password.

APN

ismoeNss -

i & .

[
DNS/IP addre! |211.144.120.104

<
°

| After Confirm succeed, the diff
| LED (yellow) on receiver will flash,
| and software can get a fixed
result.

1021-1022
1023-1024
1025-1027

VRS ® ® |t also provides TCP protocol.

5.8 Internal GPRS Mode

For Internal GPRS mode, N5 receiver supports Point to Point/Points and Ntrip client
mode. To acquire the APN (access point number) from the mobile service provider,
you need to insert a SIM card into the N5 receiver. It commonly acquires the APN

from the mobile network provider, otherwise try to get via the link:
27
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http://www.hw-group.com/products/HWgq-Ares/HWgq-Ares GSM APN en.html#top

5.8.1 Point to Point/Points mode (P to PS mode)

In point to point mode, the correction data is transmitted from the base station to
the server, then rovers can log on the server to get the correction data. Therefore,

SIM cards are required both in the Base and Rover.

Tip: ComNav technology provides a free static server address 211.144.120.104:8888, anyone can

upload CORS data as long as abide by the agreement.

Below shows Base configuration with ComNav server:
® Server: select SINOGNSS server(IP: 211.144.120.104 and Port:8888)

® BaseName: Click BaseName to get SN of Base receiver directly, when start

Rover, just select the name as source
Differential mode: make sure to choose RTCM32

Fix Position: Click Library choose to select a known point for the Base, or Get

from GNSS if you do not have a known point.

Soonn

talink Tyy Internal GSM > Datalink Ty (el GEM > e et m
CORS > Prot SinoGNSS Nam Base
Port 211.144.120.104:8888
CMNET {»
Differential mode RTCM3.2 >
SINOGNSS v = Local grid coordinate >
rr Fix position >
v e 211.144.120.104 N 3469651.507
Ma 10
8888 E 337583.694
- 4 28.439

1.850
(O Bottom of receiver(H) (@) Slant(S)

T30(NGS) >

T T R

After successfully starting the Base station, the differential LED (yellow) flashes

once per second, which means the Base is broadcasting correction data;

Configure the Rover as below:
® Protocol: Select SINOGNSS directly;

® BaseName: Enter the SN of the Base receiver.
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€& Datalink Type

Datalink Type Internal GSM >
Protocol SinoGNSS >
APN CMNET {>

SINOGNSS 3l I—

DNS/IP addre: 1211.144.120.104

Port 8888

5.8.2 Internal 4G Ntrip client mode

For Ntrip client mode, Rover acquires correction data from Ntrip(CORS) server.

& Datalink Type

Datalink Type Internal GSM >
Protocol CORS >
APN {CMNET @
Server SINOGNSS e
1 ® Enter proper APN, DNS/IP Address
DNS/IP address  {211.144.120.104 ‘
f and Port.
Port isaas
urce List S . .
| ! - ® Click Source List, select the proper
Ve o | source-> enter User and Password
VRS .
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6 Basic Survey Functions

This section describes the basic survey functions of Survey Master, including point
measurement, Topo survey, Auto survey, Area survey, Static, PPK, staking, site
calibration, import and export measured points.

6.1 Topo survey

Click Topo Survey-> enter point name, ->click © tostartor stop collecting data.

® You can quickly change antenna height in the survey interface.
® Tap Elem to check point coordinates.

® Tap Layer to show the layers you want display on map.

-
J

Exit guide Exit guide

ComNav Help

Topo survey Detail survey Auto survey

2] (17]

e
L

[Click to exit the guide, click elsewhere to continue [Click to exit the guide, click elsewhere to continue

Stake Point Stake Line Stake Arc
- -
4 Swipe left and right to change
Stake CAD Area survey PPK occupation time

Start Surveying (
)
X

z (P
Road Design Road stake Road Store \'*6 °

E] O] o O

Project Device Survey Tool
N:3469652.680 Status:Fixed N:3469652.682 Status:Fixed  B:31°21'00.05140'N Status: Fixed
E:337582.165 7:27.026 E:337582.161 7:26.830 1:121°17'33.11874'E H:26.827
[41.£3091s @ oiHooosvoorr  []81.&20916 @ 301 H0004V:0006 (741 gHoo/15 @ -7 D1 H:0.004 V:0.006
& Topo survey & Topo survey Help & Element Help
Layer Points Stake points
Y Teoom
Name ® %0 kL
Phegory N E
Layer &
Code ra o Base:p0 Surv... 2 Auto base No offs.
(%) . %% E%ﬂ
Height ¢ ; 2 oN (&) Base:p0 3469640.264 337553.735
”.:.". =3 € "s‘m"_y
s Al ERE
MU
B2 a
[ | 8 LinmEsn
{ | HEAmL
l Map:- 7 B
Map is unavailable when Base station offsets!
N‘n-vu!‘;ﬂl X | antenna P 1.800 5
N:3469653.517 Status:Fixed N:3469653.502 Status:Fixed
E:337582.058 Z:27.154 E:337582.062 Z:27.159 B Q +
8 &31218 @ <o Ho0os vooos  []5agd1218 @ :301H0005v:0007  Detail  Search  Multi-select Add
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® Fast survey by pressing Code: Tap the code in nine panels, will survey the point
directly.

Go into code management interface to modify code list ,then you can choose code

to use in nine panels.
@ Name Points Lines  Polygons

—

iz
b4 ®
- 3 2 2 2
LaJ Elem
<]
) B
@i
Cancel Features
1 rose shrubs. +
Name Antenna P 1:850 J Undetined
@ Point flower rose
Code|rose - =/
N:3469652.674 Status: Fixed .
olygon
E:337582.166 7:27.056 ’ B 2 ® +
[hg2nns @ <3 p1H0008 V0010 Modify  Apply  Import Add
® Recover deleted points in Recycle Bin.
Cancel 1 selected Select all
& Element Help Cancel 1 selected Select all
Points Stake points
Points Stake points Category N
D B L] Category N © Base:po Surv... 1 Autobase No offs
O ©BasepoSurv. 3 Astobase Noofis ©@Basep0Surv. 2 Autobase Nooffs.. X p0 3469652678 33758
0 ® sasepo 3469640.264 3 ® Base:p0 3469640.264 337553.7
O xwm 3469652673 B oxm 3469652673 337582.1
X p0 3469652.678 33
Delete
Import
Recycle Bin
® T B Q I L. ) W
Add to Stake points o [ 281 SEEE)  liedks: bt Recover Delete

31



SinoGNSS® N5 User Guide

6.1.1 Survey settings

Survey Display Road Bubble PPK

Fixed

H.RMS 0.030

0.040

0.500

taking rang 0.500

& Setting

Survey Display Road Bubble PPK

Norh/South/East/West >

Height diff ref Stake point >
Height diff Fill/Dig >
®

ito centered @

rvey bo ary Off

6.1.2 Bubble setting for Tilt survey

Bubble option will appear when receiver supports for tilt survey, it is available for

Fixed: only fixed result can be saved;
Duplicate name: allow point name same;

RMS: point accuracy need higher than
the value;

Offset radius: point cannot offset bigger
than the value during measure;

Occupation time: measure times for one
point;
Point stepsize: for point name;

Stake range: show circle when close to
target point;

Direction guide: 3 methods showing
guide for stake out;

Electronic compass: Use controller
compass during stake out;

Auto centered: Map will go to current
location after 5 seconds;

Keep centered: Map will go to current
location after 1 second;

Display survey points: will show all
survey points on map;

Display Basemap: for showing DXF/SHP
file on map

ComNav Technology N5 GNSS receiver, use IMU sensor.

According to the IMU sensor, can not only meets the requirement of high precision
measurement, but also relieves the users from continually checking whether the
pole is plumb. When the pole tilts within 60° , the built-in sensor based IMU

precisely calculates the actual offset, which accuracy can up to 2.5 cm
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& Topo survey Help & Topo survey Help
=3 s00m =5 s0m
o %V g %V
':Yi' @ Layer @
= EIEES r o EWEE Sy
LdJd Elem & a"“'v'%h Elem
P T30 » %
() A survey ® ; survey
A LasEns % LamEE
HiEAmAE ' X HzamAa
8 MU a
a8 LR ] LB
HRBMRL HEREERL
% Q m%
\~ -4
5

Name [p1] X | Antenna P 1.800

5
Name|p1| X | Antenna P 1.800

Code" W ‘l (iodp’ 4 ]
N:3469653.608 Status: Fixed N:3469653.502 Status: Fixed
E:337582.196 Z:27.125 E:337582.062 Z:27.159

Q ‘.‘49‘!&1 5/19

@ -5 1 H:0003 ;0,003

[)sager2ns

@ =5 01 H:0.005V:0.007

1. Open IMU: Go into Topo survey—click the button to open.

= ComNav Help & Topo survey Help & Toposurvey
@ s @
. @ |8 % e
Topo survey Detail survey Auto survey Layer e a
& ) e
a9 RS ra
L Fad - La . . e
e @ @ . e Initial tilt fen
.‘ @, Lrver ." _) 1. Keep the receiver stationary; _T‘?:, 4
Stake Point Stake Line Stake Arc ~ @ A ﬁ;:%’éc’f} » 2. The panel is facing you, walking ﬂ*li}
i 2 L o8 MU 10 meters forward; =
% a iBmEE 3. Shake the receiver back and forth; i
HEAML 4. Tilt initialization completed ‘Eﬂ
Stake CAD Area survey PPK waax Q) =%
O Automatically hide after
initialization
O 0 ¢ A
» Hide
Road Design Road stake Road Store 5 |
N:mm Antenna P 1.800 Name|p1 X | Amenna T 1w 2
B © O O w o sl ©
Project Device Survey Tool
N:3469652.680 Status:Fixed N:3469653.502 Status:Fixed N:3469653.529 Status: Fixed
E:337582.165 Z:27.026 [E:337582.062 Z:27.159 E:337582.059 2:27.118
M4 Z809ns @ piHooosvooor  [J8a&R2s @ =501 H0005Vv:0007 [ 52831319 @ 31 Hoo0v0013

2. Initialization

If you power off the receiver or freset it, need to initialize again. After open IMU
button, you can follow the guidance in interface to complete it. During operation,
make receiver can search the satellites and get a fixed solution.
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e foResNE - 6 RS -
" ® ® ®

Tl —_— PR —_—
| . Initial tilt - Initial tift 1 B -
Lﬁ. 1. Keep the receiver stationary; & @ . 1.Keep the receiver stationary; & B - Keep the receiver stationary; &
5 X + 2. The panel is facing you, walking
ra 2. The panel is facing you, walking £ ./ 2. The panel is facing you, walking A \ metare fanwa
LJ L 10 meters forward; g. L 10 meters forward; :E.. v 10 meters forward, S'.
5 oy » 3. Shake the receiver back and forth; @ o r ] The receiver tms slowly 90
® [3 1 ® o egrees;
T ;Nl: survey — =
P ‘ ﬂ l‘ am‘ > .
My MU MU 90
-
it
- R
3. Shake the receiver back and forth;
4, Mz'. |2'.\a\ zation completed 4. Tilt mme\wazﬂwon completed 4. Tilt initialization completed
—A 0% S 40% . 55%
utomatically hide after 3 Automatically hide after 3 " " 3
Name o initialization i Name O initialization | Name D ﬁ%ﬁnﬁ;ﬂw hide after g
“ - . D
Code Hide , Code| Hide 4 Code Hide
N:3469653.523 Status:Fixed N:3469641.904 Status:Fixed N:3469642.086 Status: Fixed
E:337582.055 Z2:27.143 E:337540.616 7:35.432 E:337540.799 Z:35.442
Oigen @ 01 H0003 V0003 Qe £326/30 @ 01 Ho001 V0003 [g345£328/33 @ < 01 H:0.001 v:0.003
Walking 10 meters shake the receiver rotating the receiver

In survey interface, you can find the bubble and angle value shows the pole you tilt.
For more accuracy, angle less than 60° will be better.

& Topo survey Help
Layer @
rA
La E“
) A ;@;

I
i

5
Name [p1] X | antenna P 1.800
Code - @

N:3469642.192 Status: Fixed
E:337540.652 Z:35.455
:45@29133 @ = 01 H:0.001 v-0.002

Tip: Do not shake or rotate the receiver violently, otherwise you need to re-initialize.
6.2 Auto survey/Area survey

For Auto survey, it supports automatic and continuous survey according to Time or
Distance.
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& Auto survey Help

et om
orer &
She iaoh
rn
Lol 40 Elem
o Vangiing
w5
Ba v}
¢ Jaose ] shrubs +
m:w Antenna P 1.850
N:3469652.679 Status: Fixed
E:337582.176 Z:27.018
Ongon? @ =i b1 H0014v:0017

For Area survey, it can compute area directly after getting points.

Press =, it will show the coordinate information, press = , it will show the area

e
result, press = | it will show the shape on map.

&  Areacalc Help | € Areasurvey Help

Name N ®
—
:op2 3469652.441 337581.644
Layer &
=op3 3469652.373 337581.800 rA 8
La y
-
:opl 3469652.673 337582.165 » 7 o
() 7 Points

Result

Area = 0,036ni
Area = 0.000054mn
Circumference = 1.214m

CANCEL

rose shrubs +

Name X | Antenna P 1.850
Code - @

N:3469652.681 Status: Fixed

e =] . E:337582.175 Z:27.030
o Shape Library choose ° D s1.£0n7 @ -3 01 H:0.008 V:0.010

6.3 Stake points/lines

Go into Stake point interface, click to choose a point and tap Stake. Survey Master
provides a navigation map when staking points/lines. If you are close to the target
point enough, it will alarm you based on the alarm range you set.
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Enter the point name and code based on your requirements, then click @

S ComNav Help & Stake points
Input point name or code
® 9. 9.
Toposurvey  Detail survey  Auto survey AET L >
® ¢
Stake Point Stake Line Stake Arc
Stake CAD Area survey PPK
®© 6
Road Design Road stake Road Store
N
O] o ]
Project Device Survey Tool
N:3469652.680 Status:Fixed
E:337582.165 Z:27.026 © 5] e —+
41, &3oors @ =7 01 H:0.005 v:0.007 Stake | Detail  Librarychoose  Add
& Stake Point Help & Stake Point Help & Stake Point Help
® < K o1 > &< < p1 > D < 1 > @
230" [ " E &
- b,
W o f a0 oy,
300'\\\\\\\\ N ////////30 N \\\\\\\ N K e
S % 0.028m ' o
270‘§W @ Stake
= ‘ w e
2407~ Z
2, R 0.023m P
7, s 1200 — e 80
20 T =
A 150° =
—~_=Dig —Y_=Dig
0.043m 0.031m 0.037m 0.027m

NamelEY.p1.d X | Antenna P 1.850 &
| @
Code| v

Namelevord X antems P 1050 °

5
aneoid X| s P19
o) @

Code - @

B:31°21'00.04950"N Status:Fixed ~ B:31°21'00.04986"N Status:Fixed B:31°21'00.04988'N Status: Fixed
L:121°17'33.12017"E H:27.090 L:121°17'33.12002"E H:27.094 1:121°17'33.12016"E H:27.082
04280013 @ <o Ho006vo00s  [Ji2£20913 @ <o Ho0s V0007 [z £d0s1a @ - 01 OO0 V0010

Various navigation info choices

You can also Import points for staking, or add from Library choose.
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Cancel 2 selected
D Category N Input point name or code Q
@ Base:p0 Surv... 7 Auto base No offs
D Name N Ef
D S — . _
D » 12 3469652.620 33
D - 11 3469652.675 33
X p3 3469652.373 33
X p2 3469652.441 33
D X pl 3469652.673 33
D X p0 3469652.678 33
] © B e aF
0K Stake  Detail Library choose Add

Tip: keep your receiver vertical to the ground.

+
For staking lines, click *«

Stake

& Stake points

Input point name or code Q

Name N =
pl ™ 3469652673  337582.165
p2 ™ 3469652441  337581.644
p3 ™ 3469652373 337581800

Import

Export

Delete

Clear data
Detail  Library choose Add

-> add line (Two points or Point + Azimuth + Distance) ->

click -> Choose one line and click Stake. The default method to stake is “To

line”, press method to choose a method you want.

e S e —

|nput code or name

..

Topo survey  Detail survey Auto survey Linet.. Name Startpoint End point
@ @ FEEEE—
Stake Point Stake Line Stake Arc
Stake CAD Area survey PPK
Road Design Road stake Road Store
_—
B @ 0 )
Project Device Survey Taol
N:3469652.680 Status:Fixed
E:337582.165 7:27.026 © E A +
M41.£3095 @ GooHooosvopey  Stake Detail impart Add
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@ Two points
Line type
Name

Code

Start point

N

End point

N

() Point+Azimuth+Distance
[7] 3D line
{Iinez X }

p2

i

3469652.441

337581.644 ‘

‘27.039 ‘

3469652.373 ‘
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& staking line
< line1 0.063m
po
Layer @
rA
LJd E%n
¢
A -
e Type
1
K0+000.041
W: 0.024m D: 0.024m
St 0.002m Dig: 27.098m

5
Name |FY_line X | antenna P 1.850

Code [ v

B:31°21'00.04989"N
L:121°17'33.12012"E

[ ez &20sna

6.4 PPK

PPK (post processing kinetic) is the unique function of survey master, which is used

Status: Fixed
H:27.098
@ = 01 H:0.008 v-0.008

To line

TO station ID

Distance of 2 points

To station/offset

To station/angle

Segments

for post-processing dynamic measurements.

It also needs two receivers to work together, one work as Base to record static data,

and another one work as Rover as shown below.

point on line;

defined interval;

point and end point;

segment value.

e To line: show shortest way to find a
e To station ID: stake points on line by

e Distance of 2 points: show distance
of current location to the line’s start

e Segment: Stake on line by defined

1. Click PPKin survey interface -> choose or create a PPK file.
2. Go to settings, configure PPK settings based on your requirements.
3. To get stable epoch, click N to initialize -> @ to start PPK survey.

=
T

J

ComNav

L

Topo survey Detail survey Auto survey
@ O
Stake Point Stake Line Stake Arc
Stake CAD Area survey PPK
6 O
Road Design Road stake Road Store
-
@ o O
Project Device Survey Teol

B:31°21'00.04933"N
L:121°17'33.12024"E

D;z@wma

Status: Fixed
H:27.090

@ <7 01 H0.004 V0,006

B:31°21'00.05536"N
L:121°17'33.11381"E

®
Nt =
o X s 1] &

A\

Epoch0/0

V.mu}pd X | Antenna P 1.850 =

Status: Single
H:26.661
o3 o D:99 H:0.122 v:0.084

[132.821318
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ComNav.cnb
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é i St e

Survey Display road PPK
Occupation time ‘|15| X ‘
Init. time (s) 300
Valid SVs 7

10

Locking time(s)

SNR 25

PDOP 6

Dax @
e
‘ ‘E[X‘ %] @
,,,,,, o
File
ik
3 iR
£p0cn 0/0
Name|p2 X | Antenna P 1.850 1
EX- @
B:31°21'00.05536"N Status:Single
L:121°17'33.11381'E H:26.661

M52.8213n18

(e} ] D99 H0.122V:0.084

6.5 Site calibration/Grid Shift

6.5.1 Site calibration

Site calibration is commonly needed once in one project, and all the points will be
collected based on calibrated datum system.

1. Choose manual pair or auto pair.
H ComNav Help
Site Calibration Grid Shift Area calc
®
coGo FTP E-mail Pair mode
O Manual pair @ Auto pair
Auto pair: according to same name for known point
and GNSS point;
CANCEL  CONFIRM
® 9] [
Project Device Survey Tool
N:3469652.627 Status: Fixed
E:337582.185 7:27.064
Mi2.£21319 @ -5 01 H0.005 V0010
2. If you choose manual pair, you can directly enter at least three groups’ point to

compute. (for example, take K1,K2,K3 as known points, take A1,A2,A3 as
measured points) After click Compute to calculate, the software will calibrate
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automatically.

i =
Click to add _

Kl K2 K3 Control point Control poi.. GNSS peint H.Resid V.Resid Method Control poi.. GNSS point H.Resid V.Resid Method
’ 7

K1 Al H.&V. K1 Al 0.022 0.000 H.&V.
Name

| | K2 A2 H.&V. K2 A2 0.062 0.000 R
N

K3 A3 H.&V. K3 A3 0.075 0.000 H.&V.
: | |

‘

C"Ck tO add - @ Succeed :s:ver;mal Ca'lhﬁﬂor;'

GNSS point =]

ALALAS |\ [
T
S .
o |

3. If you choose auto pair, it will auto compute according to the same name for
known point and measured point. After click Compute to calculate, the software
will calibrate automatically

Site Calibration Help Site Calibration Help

Controlpoint B  peteaualael CNaS ogint  H.Resid V.Resid Method Control poi.. GNSS point H.Resid V.Resid Method

K3 K3 H.&V. K3 K3 0.075 0.000 H.a&vV.

Name

| | K2 K2 H.&v. K2 K2 0.062 0.000 H.&V.
N
: | |
‘
GNSS point = @
: L ]
: ]
: | |

K1 K1 H.&V. K1 K1 0.022 0.000 H.&V.

Succeed for horizontal calibration!
Succeed for vertical calibration!

4. Click Apply to confirm to replace datum. The value of H.Resid and V.Resid should
meet the requirement (H.Resid < 0.015m, and V.Resid < 0.02m).
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(— Current projection datum Help

Datum Store
Datum China/WGS 84
Target ellipsoid WGS 84 >
Projection Ut™m >

Site calibration succeed!

Seven pal.icioie Close >
H.RMS Open >
V.RMS Open >
Geoid Model Notuse >

6.5.2 Grid Shift

Grid reset function is applied when you need to change the position of Base station
in the same project.

Click Grid Shift in Survey interface -> add current Base point and target Base point ->
Click Compute -> Apply to complete grid shift.

& Grid Shift Help
e @ Click to add the point from one Base
N 3450043.895
E 346366.943
z 25125
Known poin = . .
o = | Click to select the same point from another
N ’3450043.354 X ‘
E ’346366‘890 ‘
z ‘25.470 ‘
AN -0.029
AE -0.053
AZ 0.345
ol | e ||
6.6 COGO

With COGO function, you can calculate points/lines/angle directly on field.
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il
J

= ComNav Help & coGo E
@ @ Angular transformation >

Site Calibration  Grid Shift Area calc Two Points 4

@ Point to line >

COGO FTP E-mail Offset point >

Deflection angle >

Deflection point >

Intersection point >

Bisection point >

= ® O] (] Points from line >

Project Device Survey Tool

N:3450043.909 Status: Fixed Point average >
E:346366.937 Z:25.154
D 2 80ane @ =7 01 H:0.005V:0.009

e Angular transformation: Angular type transform;

e Two points: Calculate two points distance;

e Point to line: Distance from point to one line;

e Offset point: Calculate point with azimuth and distance;

e Deflection angle: Calculate angle of two lines;

e Deflection point: Calculate point with angle and distance;

e Intersection point: Calculate intersection points from two lines;
e Bisection point: Calculate point from angle bisector;

e Points from line: Calculate points on line by distance or segment;
e Point average: Calculate average from points;

7 Data Export/Import

Survey Master supports to import/export data including grid coordinate, Lat/Lon
coordinate with various data format, support import DXF/DWG file and export result
of DXF/KML, etc.

7.1 Import

Tap Import in project interface ->Choose Grid Coordinate/WGS84/Local LanLon ->

Click Path to add files.

e Data type: you can select a predefined type or click Add to create a
User-defined type.

® File format: support *.csv, *.dat, *.txt format.
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& Import Help & File format & User-defined

Local WGSB4 Local
@ grid LatLon O LatLon CASS D Header
File format CASS > oelmiter Comma() > Fiefommst o
Name,Code,N,EZ
Point type Input point >
Select all Clear
Name Code N EZ Avallable Selected
i ks 1 Code
Name,NEZ
Name
Name NEZ N
N EZ Name E
Z
Name,Code,EN.Z
B
Name Code EN Z L
NameEN,Z 't
Preview (.csv)

Name EN Z

I R BT

7.2 Export

Tap Export to export survey points.

e Data type: you can select a predefined type or click Add to create a
User-defined one.

e File format: support *.csv, *.dat, *.txt format.

® The default export path is .../Sinognss/sm/data/export

e =ee i e S

Local WGS84 Local
grid LatLon LatLon CASS [ Header
File name CcmNaV_pjkI X Name,CodeNEZ Delimiter Comma(,) > File format .csv ¥
Directory /Sinognss/sm/Export > Name Code N E Z Available Select all Selected  Clear
v Control Code
Point type D Input point D point NameN,EZ
s Name
w Survey
i [ Base Name N E Z N
Data type DAT > NE Z Name E
z
CASS
Name,CodeEN,Z
B
Name Code ENZ L
NameEN.Z
Preview (csv)
Name EN Z

e L 1 R

7.3 Import Basemap

Tap Basemap to import DXF/DWG/SHP file into Survey Master.

e Add points: Save points from the dxf/dwg/shp file to element.

e Add lines: Save lines from the dxf/dwg/shp file to element.

e Prefix: Support add prefix name for points/lines saved to Elements.
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Remember go survey settings to check on display basemap, click zoom button to

Wizard Datum
Element Code Basemap
Import Export Export Result
©
Features Cloud Settings
= ® ® @
Project Device Survey Tool
N:3469652.622 Status: Fixed
E:337582.169 Z:27.066

[2&30n8

auto show basemap.

@ =3 01 H0.002 V:0.003

& Setting

Survey Display Road Bubble PPK
Height diff ref Stake point >
Height diff Fill/Dig >
Electronic compass .
Auto centered .
Keep centered

Display survey points .
Display Basemap .

Go Topo survey again after uncheck

Font size

Survey boundary

7.4 Export Result

Export result including export the survey points with detailed information, stake

CAD

Shapefile

r:md»\r v J
N:3469652.608

E:337582.163
528309120

points/lines, DXF, KML, RAW and HTML result.

7.5 NMEA 0183 output

With NMEA 0183 function, you can quickly set to output NMEA data from lemo port
or Bluetooth. In fact, this function is same as enter commands “log comX gpXXX

ontime X”.
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Choose NMEA Port -> Baud -> check commands you want to output.

R
K

Help € NMEA 0183 Output Help

— ComNav
@ e @ NMEA Port Bluetooth > ’ Th t .
IS option IS same as
Baud 115200 >
Connection Rover Base - the command
e Continue output when receiver restart ® ”sa veco nﬁg" X
Antenna 0183 Output | External radio Data transfer
o Server ‘192,1 68.1.122] X ‘
=
Device Info Position Info Register Fort ’30002 I
® @ NMEA Type [ ]
Static H-Terminal Debug data GPGGA (1.0 |s GPRMC 10 s Log coml gpgea ontime 1
-
GPGLL [1.0 s GPVTG (1.0 s
e o o |
Project Device Survey Tool

GPGRS 1.0 |s GPZDA 1.0 s

Data transfer: for transmit all the BT output to the address.

B:31°21'00.04930"N
L:121°17'33.11995"E

gl 49, £300r20

Status: Fixed
H:27.089

@ = o1 Honos V0018

7.6 Register N5 via Survey Master

Normally, the register code is like this:

ID:03401012 55:49-0B-79-23-00-00-00-95-85
FUNCTIONREG:2207453726-3851620954-0949162572-0697504466-0613618189-0027539229
Note: The length of code may different according to different requirements.

Following shows two methods to register the receiver.
» Register function

For  Register function, you need only enter the
2207453726-3851620954-0949162572-0697504466-0613618189-0027539229

number:

= ComNav Help & Register
@ @ @ Status for registered function
. Base Closed
Connection Rover Base
Rover Closed
BDS Closed
PPP Closed
Antenna 0183 Output  External radio Global Closed Restart
@ QXzC Are you sure to reboot device?
Device Info Position Info Register Network RTK Register failed! [0,-10000]
L-band PPP Register failed! [0,-10000] CANCEL § RESET
B,
Q .
Register
Static H-Terminal Debug data
I i |
— 1466-06136181 89-002753922‘4 X Ca
E] © ® =]

Praject Device Survey Tool

Register
B:31°21'00.04930"N
L:121°17'33.11995°E

2 349 Z20s/20

Status: Fixed
H:27.089

@ <% o1 Hoo06 V0018
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» Register via commands
You need copy the whole code, include the word ‘FUNCTIONREG:’
FUNCTIONREG:2207453726-3851620954-0949162572-0697504466-0613618189-0027539229

j
L0

= ComNav Help
Connection Rover Base

e = m

Antenna 0183 Output  External radio

O
5.

Device Info Position Info Register
O
H-Terminal Debug data

o © O

Device Survey Tool
B:31°21'00.04930°N
L:121°17'33.11995"E
2l $49 30020

Status: Fixed
H:27.089
@ = 01 H0.006 V0018

Valid Registered Function Number: 5.
Function: HEADING Expired tme:iﬂZU-O?—Dj m
Function: BD2SIGNAL Expired time:2020-07-C0%

Function:  ROVER Expired time:2020-07-03
Function: BASE Expired time:2020-07-03
Function: RAWMSG Expired time:2020-07-0

Current Function Status:

Function: 20HZOBS Usable: NO
Function: GNSSL3 Usable: YES
Function: HEADING Usable: YES
Function:  GLOSIGNAL Usable: YES
Function:  BD2SIGNAL Usable: YES
Function:  GALSIGNAL Usable: YES
Function: GNSSL2 Usable: YES
Function: ROVER Usable: YES
Function: BASE Usable: YES
Function: DYNAMIC Usable: NO
Function:  B3DIRACQ Usable: NO
Function: B3PRC Usable: NO
Function: ~ SLTSOFTID Usable: YES
Function: RAWMSG Usable: YES
Function: EXTCOORDREF Usable: NO
Function: ZONEGLOBAL Usable: NO
Function:  GPSSIGNAL Usable: YES
Function: INNERRADIO Usable: YES
Function: COMMONVIEW Usable: NO

Function: SPACESCENE Usable: MO

log reglist
I

8 Firmware Upgrade

&  H-Terminal

1.000,0.000,COM3,BESTVEL,BINARY,ONTIME,
1.000,0.000,COM3,PSRDOP,BINARY,ONTIME, m
5.000,0.000,COM3,REFSTATION,BINARY,ONTI
5.000,0.000,COM3,REFSTATIONINFOR, BINARY, 1
1.000,0.000,COM3,INSRTKSTATUS,BINARY,ON'
0.100,0.000,COM3,M902,BINARY,ONTIME,

3.000,0.000,COM3,FINDCM,BINARY,ONTIME,

1.000,0.000,COM3,SATMSG,ABBASCII,ONTIME,

1.000,0.000,COM3,M925,BINARY,ONTIME,

3.000,0.000,*99ae9a43

©D! POOO@. 62.‘0W000HX*H00@
A S

Copy the whole code,
and enter the cursor to
next line, then send.

hS@Diic 9 Q@ ilNQ&
290 07A00 K000 000100
@ YOO _kODie ©0@
09 O7A5%QDIO VO@
QOO 09BOIO ROODIO @ 000
AR .0@ ()G8Jsi+ /1

> D+, AiQQ-/ 0 - 998 % *

#QO5+ 0 , @z + /| - 9@

'0.99(+ 1 .904+ - )Ohl) 2 , 9y
FUNCTIONREG:

2207453726-3851620954-09491
62572-0697504466-0613618189- m
0027539229

Send command: LOG REGLIST
To check receiver register status.

Prepare a Lemo to USB cable.

1. Copy the firmware software to your PC.

2. Open the firmware program, choose “APP->Link setup”, select USB to connect

with receiver, and then click “OK”.
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Link Setup

Serial Port  (USB -

[~ Manual Update [Default Baudrate 9600)
.

0K ‘ Cancel |

3. Click “Link” icon to build the connection(this is important to check if the N5 is
connect to PC successful)

2w USE - X
App Language Help
&= pa

Setting | Link 7 If output this receiver information

Message: means it connection correctly
Connected receiver information:
SH: 83381813

sw version: 3.6.8 - 2.851
boot version: 5.8.1

4. Then click“Update” icon to start the update (a few seconds are needed), during
update, the N5 will restart automatically and all Leds on N5 should be on.

2 USB - x
App Language Help

pa | 1~

Break | Updste Version

Message:

Connected receiver information:
SH: 82361813
sw version: 3.6.8 - 2.851
boot version: 5.8.1

Your Communication Port is USBE

Begin update, rebooting the receiver...
Begin update 2881T33...

Address: D968A
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5. When the progress bar is full, and “Completed!” appears below, it means the
update has been completed and then you can click “Break” to finish the update.

A UsSE - X
App Language Help
=
Break | Update | Mersion

Hessage :

[H cted receiver information:
SH: 8331Mm3
sy version: 3.6.8 - 2.851
boot version: 5.8.1
Your GCommunication Port is USB
Begin update, rebooting the receiver...
Begin update 2881T33...
Address: 2A8BDED
Undatina Ciprpparet please wait...........
Completed?

Appendix A: 7-Pin Lemo definition

The following figures show the definition of 7-pin lemo, and the structure of

7-pin Lemo to RS232 Cable:

7 pin Lemo Description
1 Signal GND
P se7s 2 GND
0—0 3 TX data out (TXD)
oo @ @ 4 NONE
o ® 5 NONE
IIThl 6 Power In (+)
7 Serial data in (RXD)

30+3mm / Note.2

xxxx |

e

©0000)
0000
Cwmam
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» Radio:
Radio parameter  Specifications
Frequency range  410-470MHz

Protocol Transmit mode: Transparent/TT450S
Receiving mode: TT450S, Transparent, MAC
Airlink rate 9600 bps
Bandwidth 12.5kbps
Power 0.5, 1, 2 Watt adjustable
Work distance 1-5km, depends on power supply and environment condition
Modulation GMSK
» Bluetooth:

* Frequency Range: 2.402Ghz-2.480Ghz
e RF Power(Max): 4dBm
e Band Width: 2Mhz
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FCC warning:

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Any Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipment and receiver.

-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
-Consult the dealer or an experienced radio/TV technician for help.

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 40cm between the radiator & your
body.
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